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Overview 

This document demonstrates features and functions in Microsoft Outlook to help handle 

your work effectively, get the inbox back to empty and develop your own comprehensive 

solution.   

The material provides additional support to 

those who have attended our training seminars 

and coaching programmes which are designed 

to support busy professionals manage their 

complex workload with less stress.  

You might also want to check out the Microsoft 

OneNote section of our website 

(www.easetheload.com) as it can enhance your 

system further and fill in the gaps that Outlook has from the workload model. This guide 

also includes a mobile solution using Microsoft To-Do to use Outlook Tasks on the go.  

This document uses the Outlook 2016 client for Office 365 on a Windows computer.  For 

the purposes of these demonstrations, the functionality is almost identical in other 

Windows versions of Outlook but doesn’t work the same on the Web or Mac version.  That 

said, the basic ideas are still there and updates to these versions are adding very useful 

functionality.  Please remember, there is no absolute right way to set this up, so feel free to 

adjust these techniques.  

  

http://www.easetheload.com/
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Setting up the Task Views 

Most will be familiar with basic Outlook features.  Email, Calendar and limited use of 

Contacts (People).  Not so many use Outlook Tasks and here's why.  It tends to be a long 

unwieldy list.  But it can be very effective with some tweaks.  

The first thing to point out is of the Tasks function, on the 

left panel you will see a To-Do List and a Tasks folder for 

your mailbox (and possibly Task folders for other shared 

mailboxes).   

The To-Do List option will show you tasks from any mailbox and also emails flagged in your 

default mailbox.  You may already have a lot of red items in this list, if you flag emails.  We'll 

come back to this view later. 

For now, we are going to create some Task folders.  The benefit is that you won't have a 

single huge task list; instead we will divide them into various sub-sets.  Not too many; just 

enough - start with less and add more if you need to.   

How should you divide your tasks?  I tend to find a couple of workable options.  It could be 

what it's about - so task folders for Admin, Sales, Research, Training, and so forth.   

Or it could be about how you do the tasks (what David Allen refers to in GTD as "contexts).  

These might be an Agenda list for your boss, Agenda list for your team, phone calls list, 

headspace list for things that need some quiet time, a braindead list of things that don't 

need much energy, a waiting for list of things you need from other people, a 

someday/maybe list of ideas for the future.   

All of that is covered in more depth in the Organize section of Workflow in our training 

seminars.  I recommend giving this some thought, although you can change your groupings 

in the future.  If you think it would be helpful to use both approaches, in other words, this 

topic is a Sales thing and I need to raise it at the next team meeting, I will show you how to 

do this by syncing Outlook Tasks with Microsoft To-Do. 

So, to create these groupings, right click on your Tasks folder 

(not the To-Do list or a shared mailbox Tasks folder).  Choose 

"New Folder ..." and type your first folder, hit the Enter 

button.  Then right click on your root Tasks folder again and 

choose "New Folder ..." - repeating this as many times as you 

need to create your structure.  You can edit this as many 

times as you want in the future. 
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That's the basic set-up, but you might want to use the To-Do list view as well.  

By default, this is a long red list (often filled with flagged emails), but we can 

adapt this.   If you want to get a fresh start, and the flags on the emails are 

not working, meaningless, click Ctrl + A, to select everything, then select 

"Remove from List" on the top menu.   

If you feel the flagged emails do have meaning, skip this step, but I would recommend you 

come back to these flagged emails in the next few days and remove the flags from 

irrelevant ones and convert the others as we will demonstrate later.  

Now select the "View" tab from the 

top, "Change View" and select the 

"Active View".  Finally, change the 

arrangement (sorting) of tasks to be 

by "Folder" rather than "Due Date".   

You'll see that you can edit these 

views very quickly at any time.  

That's all the setup done.  In the 

next section we'll show you how to 

start populating these lists.  
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Creating Tasks manually 

To start creating tasks, select one of your task folders first - for example "Agenda - John".  

As an aside, if you forget to navigate to the correct folder, the task will be created in the 

root folder and can be moved later. 

Now select "New Task" and the subject line is the title of the task.  Good practice for any 

tool you use for To Do lists includes starting the task with an action word (the more specific 

the better) and plenty of detail so that you don't have to rethink it when you see it a week 

later.  Many times, I see "John" on someone's To Do list, which was clear when they wrote 

it down, but quickly loses its meaning.  

Now add a due date, if it truly has 

one.  I will show you how due dates 

can be useful when using your 

calendar to also see tasks.  For now, 

why not add one for this test?  Other 

features on the top menu include a 

"Priority" level.  This is set to 

"Normal".  Why not change the priority for this first task to "high" (again I will show you 

how this can be useful in a later section)?   Use "high priority" sparingly, otherwise it loses 

its value.   

You can make tasks private, which might not be necessary because unlike your calendar, 

tasks are not usually shared by default.  There are options for recurrence, which is useful 

for regular tasks and works similarly to recurring appointments, with plenty of options.  You 

can assign tasks to other people; this isn't a feature I use; I'll show you another way later.  

You can mark a task as complete; there are other ways to do that which I'll point out later.   

There's also a way to send tasks to 

OneNote - there is a OneNote button 

in most Outlook menus.  These are 

reviewed in the OneNote section of 

our website.   

There are plenty of other task 

options, but these are the basic that I 

use.   I suggest now quickly creating 

two or three more real tasks as we 

have done above, finding them on 

your Outlook Tasks list, before moving to the next section.  
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Making Emails into Tasks 

If much of your work is derived from incoming emails, how can you make an email into a 

task?  There are a couple of ways.  The default method is to flag an email - that's not always 

wrong, but there are a few weaknesses.  Firstly, very few emails have a subject line that 

defines the task.  In addition, the flag automatically gives a due date of today, so we end up 

with a long list of flagged emails which go red.  

Another method which is more flexible and powerful is to drag the email down to the Task 

Bar and drop the email.  This now creates a new task from the content of the email - at this 

stage the subject line is still the same as the email, but you can change that to be more 

meaningful.  Add additional details (as you would a manual task), click save and close and 

now you have made a new task from the email.  

There are some useful variations on drag and drop.  For 

example, an email may have come in from an external 

person asking to meet (rather than a meeting request), so 

we can drag the email to the Calendar and it now creates a 

new appointment.  Again, change the details, date and 

time, and save and close.  

If an email has an attachment (perhaps an agenda for the 

meeting), the standard drag-and-drop loses the 

attachment.  However, if you hold down the right mouse 

button and then drag and drop to the calendar it offers to 

take the attachment of the email, which also allows you to 

work later with the email in its original format.  

Based on that, if you ever get multiple emails about the 

same thing (task or appointment), select the emails using 

the control key and click the mouse on the emails.  Hold 

down the right mouse button, drag-and-drop to tasks and 

choose the second or third options (copy or move emails 

as Task with Attachments).  It will now create one new 

task with the emails as attachments in the task.  It's based 

on this that we can begin to get our email inbox to empty, 

which I will cover in a later section.  
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Consolidated view of Calendar and Tasks 

Because many feel more comfortable using calendar rather 

than tasks, we end up putting all of our tasks in the calendar.  

People quickly fill up Monday morning with lots of 30-

minute tasks - things they need to do in the next few days.  

There are a few weaknesses with this technique - first it fills 

up the calendar with things we can't actually do at that time, 

because, for example, we are already in a meeting.  So, then 

we have to remember to keep moving them along, or we've 

lost them in a few days.  

Instead, as long as you are viewing your own 

calendar (not someone else's), and as long as you 

aren't in the month view, you can choose the 

"View" tab, then the "Daily Task List".  Set this to 

“Normal” and the tasks will now show 

underneath the calendar based on their due date.   

The benefit of this, is that tasks with due dates of yesterday or older, won't be lost, but 

instead will move along each day until we've marked them as completed.  For example, you 

might start Monday morning with some planning and notice the start of the week is full of 

meetings (that's a whole different topic!) but a little more space later in the week.  So, you 

can drag the tasks further into the week and that updates their due dates, making the week 

a little more manageable.  

You might also decide that one of these 

tasks is a lengthy process and want to 

block time in the calendar for it before 

anyone else books a meeting.  Drag the 

task to the calendar and now an 

appointment is created as a separate 

entity to the task.   

In addition, there could be a meeting 

that you need to prepare for.  You can 

drag an appointment to the Daily Task 

List and it will create a new task, 

independent but based on the 

appointment in the calendar.  
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The Daily Task List can be very useful but doesn't have much flexibility.  For example, it 

won't show tasks that don't have a due date.  However, there is another option; select the 

Tasks from the To-Do bar which will now show your Tasks to the right hand side of the 

calendar and this has more options including changing the sorting by Due Date, sorting 

them by Folder, create filters and more.  

 

As an aside, the main way to mark a task as complete, is to click the red flag.  Doing that 

doesn't delete the task, it just moves it from the active view to the "Completed" view.  This 

is useful as it keeps an audit trail of tasks you have completed, adding an additional 

automatic field, showing the date they were completed.    

So, Outlook Tasks can be as powerful and useful as the Outlook Calendar, it just takes a 

little set-up.  
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Using Quick Steps 

Imagine if you could create a button that will run multiple actions over a single or series of 

emails.  Ever since Outlook 2010 this has been possible using a highly configurable feature 

called Quick Steps.  You won't find Quick Steps in Calendar, Tasks, People - only Email.  

Quick Steps are in the centre of the Home tab within Email.   

You will see Microsoft have given you some built-in Quick Steps such as a “Team Email”.  

The first time you click the button it asks you to configure and save it and that is the Quick 

Step ready to use.   

But as a more comprehensive example, suppose we could create a button that takes an 

email, marks it as read, moves it to a folder, creates a new task from the email and sends a 

quick response to the sender acknowledging it and letting them know you will get back to 

them shortly… 

To set up this example, click on "Create 

New" (it has a lightning icon with it).  Now 

select a name that is more meaningful.  

You can change the icon if you like pretty 

buttons.   

Now select "Choose an Action" and keep 

on adding as many actions as needed to 

create the process; think of these options 

as ingredients so you can build your own 

recipes.  

For my example, I'll choose "Mark as read" 

from the Change Status section.  Then 

choose "Add Action" and "Move to folder" 

from the Filing options.  Select a suitable 

folder (you can leave to always ask you 

which folder to put it into), but if you like 

the idea of a simplified folder structure, 

choose the "Archive" folder which you will 

likely already have.   
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Then add another action and choose "Create Task" (either with attachment or just the text) 

and finally "Reply" or "Reply All" from the Respond section.  If you click on "Show Options" 

you will notice it now allows further refinement of the Quick Step - for example you can 

pre-populate the text.  Something like "Hi, thanks for your email.  I will get back to you in 

...." You can include lots of text, signatures, and so on.  

Now select "Finish" and you will see a new button in your Quick Steps.  If you select an 

email and the new button and you will notice all the actions happen in one go.    

As an aside, if you select multiple emails, you will notice that some Quick Steps are greyed 

out, while some are still available - this is because some actions can't be run over multiple 

emails while others can.  Above is only one example; why not after think about what Quick 

Steps might make your life easier? 
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Setting up a "Waiting For" Rule 

For many people, it can be complicated keeping a handle on all the responses they are 

awaiting from other people; within their teams, other colleagues or even external parties.  

Read receipts aren't that effective, but there is a powerful method by creating a rule.  Rules 

and Quick Steps (covered in an earlier section) have similar functionality but while a Quick 

Step runs a series of actions when you click on a button, a rule is constantly sitting in the 

background waiting for a condition to be met and then will run these actions.  

So, we are going to create a process where if we need to track an email response from a 

recipient, we will include our self in the bcc field (so that it doesn't create any confusion for 

the main recipient).  A rule will then be running, waiting for an email to come into your 

inbox from you (in this case because you've bcc'ed it to yourself into it) and then move it to 

a "Waiting For" folder, flag it and be available for us to see in our Outlook Tasks view.  

To create the rule, from the main Outlook screen, choose "File" and then "Manage Rules 

and Alerts" - you may have to make sure you are online to do this.   This will present a list of 

rules you currently have running (if any are in red, this is likely because they have an error).   
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Now select "New Rule ..." and you are presented with 

some templates, but for this we will choose the first of the 

blank rules "Apply rule on messages I receive".   Choose 

next and it will take you through a three-stage wizard.    

The first stage is “Which condition do you want to check?”  

For this, choose the first option, where the email comes 

“from people or public group".  Down in step 2, this 

becomes a hyperlink.  When you click on this, it will open 

your address book and either find your own name from 

the contact list or type your own email address into the 

box at the bottom and choose OK.  

Choose next and you are taken to the second stage – 

“What do you want to do with the message” when this 

condition is met.   We will choose two actions - "move it 

to the specified folder" at the top.  And about half-way 

down, "flag message for follow up at this time."  These 

two items will need configured in step 2 at the bottom.  

Choose the hyperlink move to specified folder.  This will 

open your mailbox structure.  If you already have a 

suitable folder to chase, follow up, waiting for or 

similar, choose that.  If not, create a new folder (from 

the right hand side of the box) and call it something like 

"Waiting For - Email".  Choose Ok until you get back to 

your rule.  We will also configure the flag message 

hyperlink and change the drop down from "Today" to "No 

Date".  This will still let us see it on our To Do list in 

Outlook, but won't turn red.    

Choose next and the third stage lets you specify any 

exceptions.  Select about half-way down the options, 

"except if my name is in the to or cc box".  This will exclude 

anytime you email yourself and will only search the bcc 

field, missing out, for example, if you are emailing yourself 

a quick reminder of something you need to do. 
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That's about it.  Choose "next" and this will let you type a name for the rule.  It might warn 

you that this is a client only rule (in other words it will only run when Outlook is open.  

That's fine, choose "Apply" and "OK" and that's the rule set-up.  So, to invoke the rule, 

anytime you want to track someone, just make sure you include yourself in the bcc, and this 

process will run automatically.  

You will be able to see the message in 

the “Waiting For – Email” folder in your 

To-Do list in Outlook.  Another benefit 

of doing it this way is that while email 

folders are usually sorted by date; if you 

right click on the header dropdown, you 

can sort this folder by the person you 

sent it the emails to.   

This creates a nice "hit list" of all the things you are ‘waiting for’ from 

each person.  And if you talking with them in a meeting or on a phone 

call, you can cover these additional topics; when it's agreed they've 

been done, you can select the "Done" Quick Step which takes the 

emails, marks the actions as being complete, and moves them to the 

Archive folder.   

Of course, like Quick Steps, you can create many other rules that would help your workflow 

- it just needs a little thinking.  
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Going mobile - Microsoft To-Do with Outlook Tasks 

The Outlook Tasks feature is fine if you spend all day at your desk.  But supposing you're on 

the go, out of the office, even out of the country.  While the standard Outlook mobile app 

has email, calendar and a few other features, Outlook Tasks aren't available.  There is now a 

really powerful way to engage with Outlook Tasks on the go, if your organisation subscribes 

to Office 365, using Microsoft To Do.  This application has been developed by the same 

team that built a very popular task management solution - Wunderlist, which Microsoft 

acquired in 2015.    

The same team developed this new tool, which since 2019 has been able to synchronise 

seamlessly with Outlook Tasks.  As an aside you can also use it for personal life, home tasks, 

using a free Microsoft account and use multiple accounts on the same device.    

Microsoft To-Do is available for free on all major platforms, iPhone, iPads, Android, Mac, 

Web and in fact also as a Windows Store app.  Go to your app store and search for it.  

Having installed it, the app will ask you to login.  If you want to use this with Outlook Tasks, 

use your organisation's username and password credentials.  If you have already set-up 

tasks in Outlook as described in the earlier sections, you will now see all your tasks in each 

list.  It has a nice, easy-to-use interface and synchronises in both directions - so adding or 

editing a task on the go on your mobile, will automatically update it on the corresponding 

list in Outlook and vice versa. 

  

https://to-do.microsoft.com/
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A few other features of note.  If a task has been marked has 

having a high importance in Outlook, Microsoft To-Do pulls them 

all into an "Important" view, showing a consolidated view of all 

priority tasks.  Be a little careful not to make all tasks high 

importance, otherwise this quickly loses its value.  

Tasks that have specific dates, will also show on the "Planned" 

view in groupings of overdue, today, tomorrow and later.  You can 

also share lists with other people which can be useful in teams.  

Microsoft To-Do tasks also allow you to "Add steps" so that small projects can be handled 

effectively, though the “steps” won’t then show in Outlook Tasks.  In addition, Microsoft 

To-Do has the usual features of having due dates, reminders, repeating tasks and attaching 

supporting documents to tasks.   

A final feature I like is the first menu 

option "My Day".  This will let you 

either create tasks straight on this 

screen or add existing tasks you 

want to  handle on that day.  Once 

that day has gone passed, they will 

drop off this view, but still be in 

their specific list.   

The key to making this work is at 

the start of each morning, decide 

on a very limited number of tasks that you want to complete before the end of the day.  I 

recommend these should be strategic, perhaps things that will help you move towards your 

bigger plans.  How many should that be?   

I recommend three, as a starting point.  Actually, it's very easy to get this up to ten or even 

more.  The real win comes from working out only three.  Which three things (if you did 

nothing else today) would make you feel your day has been really worthwhile?   

At the end of this section, why not stop think carefully and add them to the list? 

Microsoft To Do is not a complicated app; it's fairly easy to use and helpful to work with 

Outlook Tasks even without having your main machine to hand.  

  



16 | P a g e  
 

Quick Parts 

There's a nice feature in Outlook; slightly on a tangent to the workflow methodology 

delivered in my courses, but very useful and simple to set up, so I wanted to quickly 

demonstrate it.  

If you regularly send the same chunks of text to people time and again, there are a few 

ways of handling it - some keep drafts around, others have a Word document.  There's a 

nice way of handling it in Outlook using “Quick Parts”.  As an example, if anyone asks me to 

send some information about my course so they can advertise it across the team I can 

simply drop in the relevant section.  If someone asks me "is there any printing to do for the 

course", I can drop in another section.  If someone asks me about the two versions of the 

course (standard and live, hands-on version), I can quickly drop in yet another. 

It is quick and can 

also include, 

formatting, bullet 

points, colours and 

even hyperlinks to 

documents.   

Here's how to 

create one.  As an 

option, go to your 

“Sent” items and 

find an email you 

have sent out with some text you might typically reuse.  Select the chunk of text and copy it 

to the clipboard.  Now open a new email and paste it into the body of the message.  Edit it 

to get the fonts and colours correct and drag your mouse over the text and choose the 

"Insert" tab.  About three quarters of the way along is a button called "Quick Parts".  From 

there choose "Save selection to Quick Part Gallery".  It will now present you with a box 

where you can give it a meaningful name, and even create categories if you end up with a 

lot of them.  Choose "OK" and close the email without saving it. 

Now imagine this is three weeks down the line and you want to reuse that chunk of text.   

Simply reverse the process.  Click on a New email (or reply to someone else's email), make 

sure you are in the body of the message and choose the "Insert" tab and "Quick Part" and 

you will find it there ready to drop in. 

 Yet another useful but underused productivity feature in Microsoft Outlook.   
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Getting a Fresh Start 

At the start of a training seminar, I promise to show participants how to get the inbox back 

to empty and keep it there.  Technically, I haven't yet done that in this series of sections, 

though it has been implied.  So finally, how do you get a fresh start if you have many 

1,000's of emails sitting in your inbox.  

There are three quick stages.   

Firstly, ensure your emails are sorted by date order (that's the default anyway) and decide 

on the shelf life of your email.  In other words, if this email is older than … three months, 

and I haven't dealt with it by now, let's be honest, I'm probably never going to do it (by the 

way, that cut off point is probably a lot shorter than you might imagine).  Now click on the 

first email older than that and move your mouse wheel to the oldest email on the list and 

holding down the shift key, click on that bottom email.  Everything is now selected in-

between.   Now drag the whole lot to an "Archive" folder.  If you have many thousands of 

emails you might want to do this at the end of a day where you can leave the server to 

catch up when you've done it.  Does that sound like a cheat?  It is, but that's fine, it's giving 

an amnesty, without actually losing the emails if you ever need to go back to them.  

The second stage is to sort your 

emails by "sender" which you 

can do from the dropdown in 

the list header.  Now, while 

holding the "Ctrl" key go through 

selecting with your mouse, 

chunks of emails based on the 

sender - people who don’t send 

you actionable emails, 

newsletters, IT reminder emails 

and so on.  Now drag these to 

the "Archive" folder as well.  

Finally, sort them back to date order.  The rest ... You'll now have to process these as was 

described in the earlier section (Making Emails into Tasks).  But in the first stage, we quickly 

went from 50,000 down to 2,000.  In stage two, we went from 2,000 down to 150.  And that 

feels much more manageable.  

So, in wrapping up, hopefully this document will have helped you set up your system to 

create a workload solution that matches our training course methodology.  Finally, if you 

want hands-on support or feel a live session would be useful for you or your colleagues, 

please contact us from the website.  We're always keen to work further with organisations. 

http://www.positivepeople.biz/

